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2. Installation Information

A. Installing from a CD-ROM:

If you are installing Primatte for Digital Fusion from a CD, use the following procedure: 

• Open the CD. 

• Double-click on Setup.exe.

• Follow the installation directions.

• Proceed to Chapter 3. Getting and Installing a License Key.

NOTE: This operation will also load some sample images and support files. 

B. Installing from the Internet:

If you have downloaded Primatte for Digital Fusion from a web page or FTP site, it will have to be expanded from a

compressed state. Separate downloads can be done to also get the manual and sample images.

• Save the downloaded file in a known location. 

• Double-click on PrimatteDF.zip.

• Save the uncompressed files in a known directory. 

• Go to that directory and double-click on Setup.exe.

• Follow the installation directions.

• Proceed to Chapter 3. Getting and Installing a License Key.

• NOTE: This operation will also load some sample images and support files. 

• NOTE: Primatte should end up as Primatte.dfp in the \DFusion\plugins directory.

3. Getting and Installing a License Key

A. Introduction

Primatte for Digital Fusion runs in ’Demo Mode’ until a proper license is received from eyeon. This document describes

how to request a license key and instructions on how to activate the Primatte for Digital Fusion software. A license can

also be obtained to activate one or more remote rendering nodes. This chapter of the manual describes how to install

and set up the license. 

B. Primatte for Digital Fusion License Key

The Primatte for Digital Fusion license key file is provided to you from eyeon and may have been FAXed or e-mailed.
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C. How To Get and Install a License Key

To request a license key from eyeon, you must purchase the plug-in and send them the Digital Fusion eight digit

alphanumeric serial number for your version of Digital Fusion. The serial number can be obtained by reading it from the

dialog box that appears when you select Help/About while Digital Fusion is running. An application form is provided on

the last page of this document. Fill out the form and FAX it to eyeon and they will send you a license key for your

machine. You can email sales@eyeonline.com to purchase a license electronically.

Installing a Primatte for Digital Fusion license:

 • The Digital Fusion license will consist of a text file. Copy the file into your \DFusion directory and rename it

dfusion.dat.

Installing a remote rendering node license for Primatte for Digital Fusion:

 •  Contact tech@eyeonline.com for up-to-date information on this procedure.

4.  Basic Operation Tutorial

Step One - Setting up the project

 • Start Digital Fusion.

 • Select File > Preferences.

 • A menu will appear to the left of the dialog box. Select the item called Frame Format from the list.

 • Select NTSC Square Pixel from the Default Format menu that appears on the right hand side of the dialog box.

 • Confirm that the Interactive, Preview Render and Final Render menus are all set to 8 bit per channel (32 bit).

 • Click on the Save button at the bottom of the dialog box to return to the standard Digital Fusion interface.
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Step 2 - Loading the footage

 • By default, Digital Fusion should have started with a blank flow already open and waiting for images. If it has

not, select File > New from the menu at the top of the screen.

 • Locate the green LD button on the toolbars at the top of the screen. Place your cursor over the button and hold

it for a second. A tooltip will appear indentifying the button as the Loader tool.

 • Click on the LD button once.

 • Locate the tool control header labelled Loader 1 on the right side of the screen and click on the arrow to reveal

the controls for this tool.

 • Click on the yellow folder icon to display a standard Windows File browser.

 • Browse to the folder with the Primatte sample images and select the ALEX-BG.tga file. Click on the Open button.

 • Select the Loop checkbox to cause this single frame background image to remain throughout all 20 frames of

our project.
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 • Again click on the green LD button on the toolbars at the top of the screen. A second Loader event will appear

in the Flow with a Merge node connecting them.

 • Locate the tool control header labelled Loader 2 on the right side of the screen and click on the arrow to reveal

the controls for this tool.

 • Again click on the yellow folder icon and use the standard Windows File browser to select the Alex.0000.tga clip.

 • Click on the Loader 1 icon in the Flow and drag it into the Large Display area immediately above the Flow. This

pastoral scene will be the background for our chromakey tutorial.

 • Click on the Loader 2 icon in the Flow and drag it into the Large Display area immediately above the Flow. This

image sequence with the blond girl Alex will be the foreground.

 • Click on the Merge icon in the Flow and move it to the right to add another icon between Loader 2 and Merge 1.

 • Click on the Loader 2 icon to highlight it and then pull down the Tools pull-down menu, slide down to Primatte

and then over to the right to Primatte and let go of the mouse button. A Primatte icon will appear between Loader

2 and Merge 1.

 • Click on the Primatte 1 icon in the Flow and drag it into the Large Display area immediately above the Flow. The

bluescreen image of Alex will appear.

 • Locate the tool control header labelled Primatte 1 on the right side of the screen and click on the arrow to reveal

the controls for this tool.

 • This is the main Primatte interface or Operational Mode selector. There are four main steps to using Primatte

for Digital Fusion and Select Background Color is the first step, the default when the plug-in is first opened.

 • Click on the Merge 1 icon in the Flow and drag it into the Large Display area. This Merge 1 image displays the

final composite view.
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 • Position the cursor in the bluescreen area (or whatever background color you are using), near the foreground

object. Sample the targeted background color. Release the mouse button, and Primatte for Digital Fusion will

start the compositing process. If the foreground shot was done under ideal shooting conditions, Primatte for

Digital Fusion will have done 90-95% of the composite in this one step.

NOTE: Primatte will work equally well with any color backing screen. It does not have to be a specific shade of

green or blue.

TIP: If you dragged the cursor in the blue area, Primatte for Digital Fusion averages the multi-pixel sample to

get a single color to adjust to. Sometimes Primatte for Digital Fusion works best when only a single pixel is

sampled instead of a range of pixels. The color selected at this point in the Primatte operation is critical to the

operation of the plug-in from this point forward. Should you have difficulties further along in the tutorial after

selecting a range of blue shades, try the Select background color operation again with a single dark blue pixel

or single light blue pixel.

TIP: If the foreground image has a shadow in it that you want to keep in the composite, do not select any of the

dark blue pixels in the shadow and the shadow will come along with the rest of the foreground image.

• The second and third steps in using Primatte for Digital Fusion require viewing the black and white Matte View 

or Alpha Channel in the Large Display area. To do this we must change the image in the Large Display area 

back to the output of the Primatte event node.

• Click on the Primatte 1 icon in the Flow and drag it into the Large Display area

• Double-click on on the Alpha Channel button located in the bottom-left area of the Large display area. 
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• The image displayed in the Large display area will change to a black and white ‘matte’ view of the image.

• Change the Operational Mode selector in the main Primatte interface controls from Select background color

to Clean background noise . 

• If there are any white regions in the dark, ‘bluescreen area’, it is ’noise’ (or shades of blue that did not get picked

up on the first sample) and should be removed. Move the cursor through these areas and sample these whitish

noise regions. When you let up on the mouse button, Primatte for Digital Fusion will process the data and

eliminate the noise. Repeat this procedure as often as necessary to clear the noise from the background areas.

Sometimes increasing the brightness of your monitor allows you to see noise that would otherwise be invisible.                                                                  

        Before Background noise removal                                      After Background noise removal 

NOTE: You do not need to remove every single white pixel to get good results. Most pixels displayed as a dark 

color close to black in a key image will become transparent and virtually allow the background to be the final 

output in that area. Consequently, there is no need to eliminate all noise in the bluescreen portions of the image. 

In particular, if an attempt is made to meticulously remove noise around the foreground object, a smooth 

composite image is often difficult to generate.
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TIP: When clearing noise from around loose, flying hair or any background/foreground transitional area, be 

careful not to select any of areas near the edge of the hair. Leave a little noise around the hair as this can be 

cleaned up later using the Fine Tuning sliders.

• If there are dark regions in the middle of the mostly white foreground object, that is, if the key is not 100% in 

some portion of the targeted foreground, choose Clean Foreground Noise from the Operational Mode 

selector. 

• Use the same techniques as for Clean Background Noise, but this time sample the dark pixels in the 

foreground area until that area is as white as possible.

         Before Foreground Noise Removal                                      After Foreground Noise Removal

NOTE: Do not select any edge or transparent areas. Edges on a foreground object are supposed to be gray and 

transparent areas (such as glass, water, gauze, etc. will also remain gray. This operation is only for areas in the 

middle or 100% foreground regions.

 • These were the steps necessary to create a clean ’matte’ or ’key’ view of the image. With this key, the 

foreground can be composited onto any background image. However, if there is ‘spill’ on the foreground object 

from light that was reflected off the background, a final operation is necessary to remove that background spill 

get a more natural looking composite.

 • For the fourth step in the Primatte for Digital Fusion operation, return the color view to the Large display area 

by double-clicking on the Color View button at the bottom-left of the Large display area. 
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This will turn off the Matte View mode.

 • The sample image below has gone through the first three steps and has examples of spill. Notice the blue fringe 

to her hair and a blue tint on her right cheek, arm and chest.

Spill Removal - Method #1
 • There are two ways in Primatte to remove the spill color. 
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The quickest method is to select the Spill Sponge button from the Operational Mode selector and then sample 

the spill areas away. 

By just positioning the cursor over a bluish pixel and selecting it, the blue will disappear from the selected color 

region and be replaced by a more natural color. Additional spill removal should be done using the Fine Tuning 

sliders which are explained further on in this manual.

Note: All spill removal/replacement operations in Primatte can be modified using the Background Spill 

Replacement tools. Spill can be replaced with either the complement of the background color or by a solid color 

selected by the user. Depending on the spill conditions, one of these options should provide the results you are 

looking for.

Note: Primatte’s spill removal tools work on ’similar color regions’. In the image above, samples should be made 

on the light flesh tones, the dark flesh tones, the light blonde hair, the dark blonde hair and the red blouse color 

regions. One sample in each color region will remove spill from all similar colors in the foreground image.

 • If the spilled color was not been totally removed using the above procedure, a fine-tuning operation should follow 

for more subtle and sophisticated removal of the spilled background color.

Spill Removal - Method #2

 • Select the Fine Tuning tab in the Primatte 1 controls window. 

 • Using the zoom and pan capabilities of the Digital Fusion application, zoom into an area that has some blue 

edges.

 • Using the cursor, sample a range of the blueish pixels that you want to remove. When you let up on the mouse 

button, Primatte for Digital Fusion will register the color selected. For most images, the Spill slider is all that is 

required to remove any remaining bluespill. 

The more to the right the slider moves, the more background screen color will be removed from the sampled 

pixels. The more to the left the slider moves, the more the selected pixels will move toward the original 

foreground image’s color. The sliding operation is performed by clicking on the Spill slider and moving the 

mouse left or right to change the value.
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Note: When using the Spill slider in the Fine Tuning mode to remove spill, spill color replacement will be 

replaced based on the setting of the Spill Replacement Button???. See Spill Replacement Button??? for 

more information in Chapter 11. Primatte for Digital Fusion Tools and Buttons.

TIP: It is better to make several small adjustments to the bluespill areas than a single major one.

 • You can use the other two sliders in the same way for different key adjustments. The Detail slider controls the 

matte softness for the color which is closest to the background color. 

For example, you can recover lost rarefied smoke in the foreground by selecting the Fine Tuning mode, clicking 

on the area of the image where the smoke just starts to disappear and moving the Detail slider to the left. 

The Transparency slider controls the matte softness for the color which is closest to the foreground color. 

For example, if you have thick and opaque smoke in the foreground, you can make it semi-transparent by 

moving the Transparency slider to the right after selecting the pixels in the Fine Tuning mode.

TIP: If the foreground image changed color dramatically during the fine tuning process, you can recover the 

original color by sampling a color region in an area of the off-color foreground image and moving the Spill slider 

slightly to the left. This may introduce bluespill back into that color region. Again, use the Fine Tuning option to 

suppress the bluespill again, but make smaller adjustments this time.

NOTE: If these final ’spill suppression’ operations have changed the final compositing results, you may have to 

return to earlier operations to clean up the matte. If the Composite view looks good, it is a good idea to go back 

and take a final look at the Matte View. Sometimes in the Primatte operation, a 100% foreground area will 

become slightly transparent. You can clean those transparent areas up by using the Matte Sponge button. After 

selecting the Matte Sponge operational mode, just click on the transparent pixels (gray in color) and they will 

become 100% foreground (white in color). All of the spill-suppression information will remain intact. 

Alternatively, you can go to the Matte view and then using the Fine Tuning sliders, select those transparent 

areas and move the Transparency slider slightly to the left. This will move that color region from 0-99% 

foreground with spill suppression to 100% foreground with spill suppression and should solve the problem.

5. Spill Replacement Options

The proper processing of spill on foreground objects is one of the many useful features of Primatte. There are two spill 

processing methods:

• Complemental Spill Replacement

• Solid Color Spill Replacement

Complemental Replacement Mode

This is the default spill replacement mode. 
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This mode will maintain fine foreground detail and deliver the best quality results. If foreground spill is not a major 

problem, this mode is the one that should be used.

                                                      Complemental Replacement Mode Maintains Fine Detail.

The Complemental Replacement mode is sensitive to foreground spill. If the spill intensity on the foreground image is 

rather significant, this mode may often introduce serious noise in the resultant composite.

Solid Color Replacement Mode

In the Solid Color Replacement mode, the spill component will be replaced by a 'user defined' palette color. While the 

Complemental Replacement mode uses only the backing color complement to remove small amounts of spill in the 

original foreground, the Solid Color Replacement mode tries to assuage the noise using the 'user defined' palette color. 

Changing the palette color for the solid replacement, the user can apply good spill replacement that matches the 

composite background. Its strength is that it works fine with even serious blue spill conditions.

                                                      Smooth Spill Processing with Solid Color Replacement

On the negative side, when using the Solid Color Replacement mode, fine detail on the foreground edge tends to be 

lost. The single palette color sometimes cannot make a good color tone if the background image has some high contrast 

color areas.
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6. Inward Defocus Feature (TBA)

A new method of defocusing the matte has been added. This new feature only blurs inward toward the center of the 

foreground subject. The conventional Primatte defocus feature affected the matte edges in both directions (inward and 

outward) and sometimes introduced a halo artifact around the object edge in the composite view. This was most evident 

when using the Complemental Replacement mode. With the Inward Defocus switch ON, the matte defocus functions 

only in the inward direction of the foreground subject (toward the center of the white area). The final result is that it 

removes small and dark noise in the backing area without picking them up again in the CleanBG Noise mode and 

sometimes results in softer, cleaner edges on the foreground objects.

7. Primatte for Digital Fusion Tools and Buttons

 Operational Mode Selector Buttons (Primatte Tab)
Page 14



• Select background color   

When this operational mode is selected, the Primatte operation will be initially computed by having the user 

sample the target background color within the image window. For keying operations, this is the first step and 

should be followed by the three steps described immediately below.

• Clean background noise   

When this operational mode is selected, the user samples pixels on the image window known to be 100% 

background. White noisy areas in the 100% background region will become black. This is usually the second 

step in using Primatte.

• Clean foreground noise   

When this operational mode is selected, the user samples pixels on the image window known to be 100% 

foreground. The color of the sampled pixels will be registered by Primatte to be the same color as in the original 

foreground image. This will make gray areas in the 100% foreground region become white. This is usually the 

third step in using Primatte.

• Spill Sponge   

When this operational mode is selected, the background color component in the sampled pixels (or spill) within 

the image window is keyed out and removed for the color region selected. This operation can only be used once 

on a particular color and the amount of spill suppression applied is not adjustable. It is the fastest way to remove 

spill from a composite image. For more accurate spill suppression, the Fine Tuning Spill Slider operation 

should follow or be used instead. This can usually be the fourth (and final) step in using Primatte unless 

additional adjustments are necessary.

• Matte Sponge  

When this operational mode is selected, the sampled color within the image window becomes 100% foreground. 

However, if the sampled color is already keyed out and removed, it leaves the current ’suppressed’ color. It only 

affects the key or matte information. This tool is usually used to quickly remove stray transparent pixels that have 

appeared during the chromakeying procedure. It is a quick and easy way to make final adjustments to a 

composite.

• Restore Detail   

With this mode selected, the completely transparent background region sampled in the image window becomes 

translucent. This operation is useful for restoring lost hair details, thin wisps of smoke and the like. It shrinks the 

small polyhedron slightly.

 • Make foreground transparent  

When this mode is selected, the opaque foreground color region sampled in the image window becomes slightly 

translucent. This operation is useful for making shadows, clouds or smoke more transparent. It can only be used 

one time on a particular color. For a more flexible way to thin out a color region and be able to make multiple 

samples, you should use the Fine Tuning Transparency Slider operation. It expands the medium polyhedron 

slightly.
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Fine Tuning Sliders and Solid Color Spill Replacement Selector (Fine Tuning Tab)

• Spill (Large Polyhedron) Slider 

When in the Fine Tuning operational mode, this slider can be used to remove spill from the registered color 

region. After selecting and registering a color region, this slider can be moved to remove spill from the registered 

color region. The more to the right the slider moves, the more spill will be removed. The more to the left the slider 

moves, the closer the color component of the selected region will be to the color in the original foreground image. 

If moving the slider all the way to the right does not remove all the spill, re-sample the color region and again 

move the slider to the right. These slider operations are additive. This result achieved by moving the slider to 

the right can also be achieved by choosing the Spill Sponge operational mode and clicking on a color region 

with spill. This slider bulges the Primatte large polyhedron near the registered color region.

• Transparency (Medium Polyhedron) Slider 

When in the Fine Tuning operational mode, this slider can be used to make the matte more translucent in the 

registered color region. After selecting and registering a color region, moving this slider to the right makes the 

registered color region more transparent. Moving the slider to the left makes the matte more opaque. If moving 

the slider all the way to the right does not make the color region translucent enough, re-sample the color region 

and again move the slider to the right. These slider operations are additive. This result achieved by moving the 

slider to the right can also be achieved by choosing the Make foreground transparent operational mode and 

clicking on a color region. This slider bulges the Primatte medium polyhedron near the registered color region.

• Detail (Small Polyhedron) Slider 

When in the Fine Tuning operational mode, this slider can be used to restore lost detail. After selecting and 

registering a color region (usually where some wisps of hair or smoke detail has been lost), moving this slider 

to the left makes the registered color region more visible. Moving the slider to the left makes the color region 

less visible. If moving the slider all the way to the left does not make the color region visible enough, re-sample 

the color region and again move the slider to the left. These slider operations are additive. This result achieved 

by moving the slider to the left can also be achieved by choosing the Restore detail operational mode and 

clicking on a color region. This operation dents the small polyhedron (which contains all the blue or green 

background colors) and releases pixels that were close to the background color. The Detail Slider in the Fine 

Tuning mode is useful for restoring pixels that were lost because they were so similar to the background color. 

This slider dents the Primatte small polyhedron near the registered color region.
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 • Spill Replacement Color Picker

These tools allow the user to select a solid color for the spill replacement color. The user can select the color is three 

different ways; by setting the RGB values of the desired color, by choosing the color from the Digital Fusion Color Picker 

or by clicking on the color chip and dragging an eyedropper to the Large Display area.

• Red Slider  

This allows the user to set a red value for the spill replacement solid color.

• Green Slider  

This allows the user to set a green value for the spill replacement solid color. 

• Blue Slider  

This allows the user to set a blue value for the spill replacement solid color.

• Pick Button  

This button brings up the Digital Fusion Color Picker and allows the user to choose a color for the spill 

replacement solid color.

• Color Chip  

 By clicking on this button and dragging the cursor to the Large Display window, the user is presented with an 

eyedropper icon and can then choose a color from the Large Display window image for the spill replacement 

solid color.
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Matte Adjustment Tools (Matte Tab)

• Matte Blur Slider  

Determines the defocusing level being applied to the matte. When using this tool, some noise may appear 

around the edges of the foreground object. To avoid this problem, try toggling to the Solid Color Replacement 

mode.

Note: With using this feature, foreground details and smoothness of motion blur may be adversely affected. Set 

it to 0 for optimum results.

• Matte Contract/Expand Slider  

Determines the degree of background penetration into the foreground around the silhouette of the foreground 

object.

Note: With using this feature, foreground details and smoothness of motion blur may be adversely affected. Set 

it to 0 for optimum results.

• Matte Gamma Slider  

Determines the overall Gamma of the matte, pushing the mid-tomes either lighter or darker.

• Matte Threshold Slider   

The Threshold slider will clip or choke the matte between the range of the slider.

8. Primatte for Digital Fusion Files

Essential Files:

These files are required for proper Primatte for Digital Fusion operation. 

Primatte.dfp - This is the Primatte for Digital Fusion plug-in. It will be in the \DFusion\Plugins directory. 

PrimManDF4.pdf - This is the document you are reading.

Optional files: 

These files are included on Primatte for Digital Fusion CDs, but are optional downloads on the web site.



\IMG - This is a directory with sample images. When used in conjunction with this tutorial, a working knowledge of 

the Primatte for Digital Fusion operation can be achieved.

alex-fg.tif - This is a foreground image of a girl against a bluescreen (640x480 pixels).

alex-bg.tif - This is a background image of a street scene (640x480 pixels).

tabako-fg.tif - This is a foreground image of cigarettes in an ashtray (640x480 pixels).

tabako-bg.tif - This is a background image of a tabletop (640x480 pixels).

water-fg.tif - This is a foreground image of a statue with water cascading (640x480 pixels).

water-bg.tif - This is a background image of a clocktower (640x480 pixels).

\ANIM - This is a sequence of images saved as alex.0000.tga to alex.0019.tga (640x480 pixels).

9. The Primatte Algorithm

Explanation of how Primatte works...

The patented Primatte for Digital Fusion Polyhedral Slicing Algorithm is at the heart of the Primatte for Digital Fusion

plug-in. To use Primatte for Digital Fusion most effectively, it sometimes helps to understand how the algorithm works.

This is a brief explanation, but to get a more extensive understanding, please contact Photron USA for a Primatte White

Paper which explains the algorithm in much more detail.

Basically, Primatte for Digital Fusion separates all of the pixels in the foreground image into one of four separate

categories. It does this by creating a 3D RGB color space for the foreground image and building three concentric

polyhedrons, one within the other and sharing the same center point. By doing this, Primatte segments all the colors in

the foreground image into one of four areas:

While the polyhedrons are displayed as circular shapes in the above drawing, in reality, they are more like globes made

up of 128 surfaces that can be distorted into many different shapes to accommodate the color regions in each unique

foreground image. Looking at the four regions that are created by these polyhedrons we can see that each region has

a particular property.
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Category #1 is the small polyhedron and contains all of the pixels in the foreground image designated as 100% 

background. This means that the foreground colors in the small polyhedron will be replaced completely with background 

pixels.

Category #2 is the region between the small polyhedron and the medium polyhedron. These foreground pixels are 

designated as the transition pixels between the foreground and the background. These pixels are where Primatte blends 

the original background pixels with the foreground. Foreground object edges, wisps of hair and smoke pixels are found 

in this region.

Category #3 is between the medium and large polyhedrons. These pixels are 100% foreground, but have background 

’spill suppression’ applied to them. This is for pixels in the center of the foreground object where you want the bluespill 

suppressed, but you don’t want background pixels blended in.

Category #4 is reserved for 100% foreground pixels that are unchanged from the original image. All the foreground 

colors that are outside the large polyhedron are exactly as they were in the original foreground image.

When in the Fine Tuning operational mode, the Spill (Large Polyhedron), Transparency (Middle Polyhedron) and 

Detail (Small Polyhedron) sliders do not increase the entire circumference of the polyhedron, they just bulge or dent it 

in the particular color region that you registered by clicking on a color region prior to moving the sliders. All colors in the 

foreground image are forced into one of the four categories. After you have done the first three steps in using Primatte 

(Select background color, Clean background noise, Clean foreground noise), the three polyhedrons are created. 

By then selecting a bluish spill pixel in the Fine Tuning mode and moving the Spill slider to the right, you are bulging 

the large polyhedron and moving the registered color region from Category #1 to Category #2. This will leave the color 

region as 100% foreground, but suppresses the blue or green tinge. It will affect all similar colors in the foreground 

image. 
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As another example, when you are in the Clean Backgroud noise mode, every time you designate a region of white 

noise, the small polyhedron enlarges slightly in that direction, encompasses those pixels and makes them 100% 

background. The left-hand image above shows what the small polyhedron would look like if you selected a single green 

pixel from the greenscreen area of the foreground image in the Select background color mode. The center of the 

polyhedron is the color of green that you selected and by making a small globe, we also grab a few other shades of 

green that are near the shade of the selected pixel. The middle image shows the shades of green (the white dots) that 

might be selected in the Clean background noise mode. These would be milky white areas in the background of the 

foreground object. The right-hand picture shows how the small polyhedron automatically bulges itself to enclose those 

new shades of green. Once they are inside the small polyhedron, they are classed as 100% background pixels and are 

replaced by the corresponding pixels from the background image. If you selected a second milky, white area, the small 

polyhedron would expand again to encompass those shades of green.

When you lose some smoke or hair detail, you can dent the small polyhedron using the Restore detail operational 

mode. These operations dent the small polyhedron in that area and releases the previously missing smoke or hair into 

the visible area between the small and medium polyhedron. 

Between the medium and the large polyhedron (Category #3) are the pixels in the center of your foreground objects. 

These have to stay 100% foreground, but do need blue suppression applied. The last category (Category #4) is outside 

the large polyhedron. These are foreground pixels that are 100% foreground and do not need blue suppression.

All Primatte for Digital Fusion manipulations involve moving foreground pixels between these four categories.

10. If you need some help…

Please contact our technical support person or tech@eyeonline.com. 
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